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SPRACHE IN Paragraph-Style “05 - STANDARD Fließtext” passend einstellen

1	 Willkommen zu GUITAR RIG MOBILE!
GUITAR RIG MOBILE ist eine professionelle Recording-Lösung für Gitarre und Bass. Sie be-
steht aus dem ultrakompakten GUITAR RIG MOBILE I/O Interface und der Essential Version 
der GUITAR RIG 4 Software.

GUITAR RIG MOBILE I/O ist ein Audio Interface in Studio-Qualität, das über die schnelle 
USB 2.0 Verbindung an ihren Computer angeschlossen wird. Es ist mit einem Eingang für 
E-Gitarre und E-Bass ausgestattet und verfügt über einen Stereo-Ausgang, an den Sie sowohl 
Stereoanlage, Mixer oder Aktivlautsprecher als auch Kopfhörer anschließen können. GUITAR 
RIG MOBILE I/O ist optimal für den Einsatz mit Native Instruments GUITAR RIG geeignet, 
funktioniert jedoch ebenso gut mit den meisten professionellen Audio-Programmen.

In den folgenden Kapiteln erfahren Sie mehr über das GUITAR RIG MOBILE I/O Interface und 
seinen Einsatz. Bitte lesen Sie das Handbuch aufmerksam durch, um sich mit dem Gerät 
vertraut zu machen.
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2	 Vor der Inbetriebnahme – Wichtige Hinweise
Auch wenn Sie am liebsten gleich loslegen möchten, empfehlen wir, dieses Kapitel sorgfältig 
zu durchzulesen.

2.1	 Seriennummern & Typenschild

GUITAR RIG MOBILE wird mit zwei Seriennummern geliefert. Die Seriennummer des Session 
I/O Hardware befindet sich auf der Unterseite des Gerätes, während die Seriennummer für 
die enthaltene Version von GUITAR RIG 4 sich auf der Hülle der Installations-CD befindet.

Das Typenschild finden Sie auf der Unterseite des Geräts. Es listet die Modellbezeichnung 
des Produktes und andere technische Informationen auf. 

2.2	 Sicheres Verwenden des Geräts

Bitte lesen Sie die folgenden Abschnitte aufmerksam durch, um gesundheitliche Risiken und 
eine Beschädigung des Produkts zu vermeiden.

2.2.1	 Achtung
Bitte beachten Sie die folgenden Hinweise, um mögliche Gesundheitsschäden zu vermeiden:

•• Dieses Produkt kann in Kombination mit Verstärkern, Lautsprechern oder Kopfhörern sehr 
hohe Pegel erzeugen, die Ihre Ohren schädigen können.

•• Stellen Sie sicher, dass alle Lautstärke-Regler heruntergedreht sind, bevor Sie GUITAR RIG 
MOBILE I/O verwenden. Drehen Sie die Regler während der Wiedergabe langsam bis zur 
gewünschten Lautstärke auf.

•• Setzen Sie das Produkt nicht über längere Zeit bei hoher Lautstärke ein. Sollten Sie 
Gehörprobleme bemerken, suchen Sie bitte umgehend einen Facharzt auf.
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2.2.2	 Vorsicht
Um sicher zu stellen, dass das GUITAR RIG MOBILE I/O oder andere angeschlossene Geräte 
während der Benutzung nicht beschädigt werden, folgen Sie bitte folgenden Hinweisen: 

•• Öffnen Sie auf keinen Fall das Gehäuse und versuchen Sie nicht, Komponenten auseinan-
derzubauen oder zu modifizieren. Die Bestandteile dieses Geräts sind vom Nutzer weder 
zu warten noch zu reparieren. Stellen sich beim Betrieb der Hardware Fehlfunktionen jeg-
licher Art ein, wenden Sie sich zur Reparatur an qualifiziertes Fachpersonal.

•• Schützen Sie das Gerät vor Regen und nutzen Sie es nicht in unmittelbarer Nähe von Wasser 
oder in nasser Umgebung.

•• Es dürfen zu keiner Zeit Objekte oder Flüssigkeiten jeglicher Art in das Innere des Gehäuses 
gelangen.

•• Setzen Sie das Gerät niemals extremen Temperaturen oder intensiven Vibrationen aus (z.B. 
direktem Sonnenlicht in einem geschlossenen Fahrzeug, auf Heizkörpern oder anderen Hitze 
erzeugenden Geräten). 

•• Platzieren Sie das GUITAR RIG MOBILE I/O nicht in einer instabilen Position, in der es he-
runterfallen könnte. Entfernen Sie sämtliche angeschlossenen Kabel, bevor Sie das GUITAR 
RIG MOBILE I/O transportieren.

•• Stellen Sie vor dem Ausschalten sicher, dass die Lautstärke sämtlicher Geräte komplett 
heruntergedreht ist. 

•• Üben Sie bei der Bedienung der Regler und Anschlüsse niemals Gewalt aus.

•• Benutzen Sie zur Reinigung des GUITAR RIG MOBILE I/O ein trockenes, weiches Tuch. 
Verwenden Sie niemals Lösungsmittel, Farbverdünner, Reinigungsflüssigkeiten oder che-
misch imprägnierte Wischtücher.

2.2.3	 Entsorgung
Sollte dieses Produkt irreparabel beschädigt werden oder sollten Sie es aus anderen Gründen 
entsorgen wollen, so befolgen Sie bitte die geltenden Vorschriften zur Entsorgung elektroni-
scher Produkte.
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2.3	 Haftungsausschluss

Die Native Instruments GmbH kann zu keinem Zeitpunkt für etwaige Schäden oder 
Datenverluste zur Verantwortung gezogen werden, die durch unsachgemäßen Betrieb oder 
durch Modifikationen des GUITAR RIG MOBILE I/O oder der zugehörigen Software entstehen.

Zum Zeitpunkt der Publikation wurden die Informationen in diesem Handbuch als korrekt 
erachtet. Die Native Instruments GmbH behält sich vor, die Spezifikationen der Software oder 
der Hardware jederzeit unangekündigt und ohne Verpflichtung zum Update bereits existie-
render Geräte zu ändern.
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3	 Bestandteile des GUITAR RIG MOBILE I/O Audio 
Interface

1	 Der Eingang (6,3-mm-Stereo-Klinkenbuchse) ist auf den Pegel von hochohmigen 
Instrumenten ausgelegt. Sie können verschiedene Klangquellen daran anschließen, wie 
zum Beispiel Ihre Gitarre oder Ihren Bass. Für die Verarbeitung von Stereo-Signalen be-
nötigen Sie einen speziellen Stecker (Insert Kabel / Y-Kabel, nicht enthalten).

2	 Mit dem Eingangspegel-Regler (Input Level) können Sie die Verstärkung des Eingangssignals 
einstellen.

3	 Mit der Eingangspegel-LED überwachen Sie den Pegel des Eingangssignals. Bei grünem 
Licht liegt ein Signal vor, während ein rotes Licht auf Übersteuerung hinweist. Dies be-
deutet, dass die Verstärkung des Eingangspegels (Input Level) zu hoch eingestellt ist.
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4	 Der Ausgang (6,3-mm-Stereo-Klinkenbuchse) überträgt das Ausgangssignal von 
Musiksoftware, z. B. GUITAR RIG oder einem Sequencer, an Ihren Verstärker oder Ihre 
Kopfhörer. Abhängig von der Eingang Ihres Verstärkers kann es notwendig sein, einen 
speziellen Stecker (Insert Kabel / Y-Kabel, nicht enthalten) zu verwenden, um das Stereo-
Signal zu übertragen.

5	 Der Ausgangspegel-Regler (Output Level) ermöglicht die Anpassung der Ausgangslautstärke. 
Drehen Sie den Ausgangspegel-Regler ganz herunter, bevor Sie etwas an den Ausgang 
anschließen; dies gilt insbesondere für Kopfhörer, die Sie bereits tragen!

6	 Die USB-LED zeigt an, ob GUITAR RIG MOBILE I/O an einen USB-Port angeschlossen ist.

7	 Der USB-Port verbindet GUITAR RIG MOBILE I/O mit Ihrem Computer. Damit das Gerät 
funktioniert, ist ein Anschluss erforderlich, der die USB-2.0-Spezifikation erfüllt.



GUITAR RIG MOBILE – 12

4	 Installation unter Windows XP/Vista
Dieses Kapitel behandelt die Installation von GUITAR RIG MOBILE unter Windows XP und 
Vista, mit Schwerpunkt auf dem GUITAR RIG MOBILE I/O Audio Interface. Detaillierte 
Informationen zu GUITAR RIG 4 finden Sie in den Software-Handbüchern. Sie finden diese 
im Ordner Documentation im GUITAR-RIG-Installationsverzeichnis; direkt öffnen können Sie 
es über das Programm-Menü von GUITAR RIG 4 unter Help > Open Manual > German.

4.1	 Installation der Software

Stellen Sie sicher, dass Sie mit Administrator-Rechten eingeloggt sind. Verbinden Sie das 
GUITAR RIG MOBILE I/O noch nicht mit ihrem Computer.

1.	 Navigieren Sie zum Inhalt der Produkt-CD und suchen Sie die Datei “Guitar Rig 4 Setup”. 
Falls Sie eine Download-Version von GUITAR RIG 4 verwenden, müssen Sie das Setup-
File zunächst entpacken.

2.	 Doppelklicken Sie auf die Datei “Guitar Rig 4 Setup”, um den Installationsprozess zu 
beginnen.
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3.	 Folgen Sie den Anweisungen auf dem Bildschirm, um durch den Installationsprozess 
geführt zu werden.

4.	 Sie werden nach dem Pfad zu dem Plug-in-Verzeichnis Ihrer DAW (Digital Audio 
Workstation, z.B. Ihre Sequencer-Software) gefragt werden. Falls Sie GUITAR RIG aus-
schließlich als eigenständige Software verwenden wollen, oder falls Sie nicht wissen, was 
ein Plug-In ist, belassen Sie das entsprechende Feld bei der Standardeinstellung.

5.	 Sie werden gefragt, ob Sie Treiber für ein GUITAR RIG Audio Interface installieren möch-
ten. Wählen Sie “MOBILE I/O” und klicken Sie auf “Fortsetzen”.

6.	 Während der Installation des Treibers werden einige Windows Sicherheitswarnungen an-
gezeigt, z.B. “Die Treiber-Software hat den Windows Logo Test nicht bestanden” oder 
“Windows kann den Herausgeber dieser Treiber-Software nicht verifizieren“. Dies ist kein 
Grund zur Beunruhigung. Klicken Sie einfach auf “Installation trotzdem fortsetzen” (XP) 
bzw. “Treiber trotzdem installieren” (Vista), um die Installation fortzusetzen.
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7.	 Starten Sie Ihren Computer nach der Installation neu.

Das Installationsprogramm platziert die folgende Software auf ihrem Computer:

•• GUITAR RIG 4 – die eigenständige Software.

•• GUITAR RIG 4 Plug-Ins – GUITAR RIG 4 lässt sich als Plug-In für Ihre Digital Audio 
Workstation (DAW) benutzen. Auf einem Windows Computer werden die Formate VST und 
RTAS® unterstützt.

•• NATIVE INSTRUMENTS SERVICE CENTER – Diese Anwendung ist für die Produktaktivierung 
und das Update-Management zuständig. Bitte konsultieren Sie den Setup Guide für Details 
zur Produktaktivierung.

•• Die Treiber für das GUITAR RIG MOBILE I/O Audio Interface.
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% Wenn Sie bisher noch kein Produkt von Native Instruments besitzen, müssen Sie sich bei 
Native Instruments registrieren, indem Sie den Anweisungen auf den Bildschirm folgen. 

Mehr Informationen über die Erstellung eines NI User Accounts und über die Aktivierung von 
GUITAR RIG LE finden Sie im Service Center Quick Start Guide und im Service-Center-Handbuch, 
die sich im Installations-Ordner des NI Service Center befinden.

Falls Sie nur die Hardware-Treiber installieren wollen, finden Sie dafür auf der Installations-CD 
eine separate Installations-Datei. Die aktuelle Treiberversion finden Sie jederzeit im Bereich 
„Support“ der Native-Instruments-Website.

4.2	 Installation der Hardware

Benutzen Sie das mitgelieferte USB-Kabel, um das GUITAR RIG MOBILE I/O direkt an einen 
USB-2.0-Port Ihres Computers anzuschließen.

GUITAR RIG MOBILE I/O wird per USB mit Strom versorgt. Die Funktion kann nur garan-
tiert werden, wenn Sie es als einziges Gerät direkt an einem USB-2.0-Controller oder an 
einem USB-2.0-Hub mit eigener Stromversorgung betreiben. Auf Windows-XP-Systemen 
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ist der Service Pack 2 notwendig – Sie können Ihre genaue Windows-Version im Fenster 
„Systemeigenschaften” herausfinden.

	

Nach der erfolgreichen Installation wird das GUITAR RIG MOBILE I/O beim Herstellen der 
Verbindung automatisch erkannt. Andernfalls starten Sie bitte die Installation erneut, wie 
oben beschrieben.

Es werden nun verschiedene Treiber mit dem GUITAR RIG MOBILE I/O verknüpft, wobei je-
desmal ein Fenster erscheint, in dem Sie gefragt werden, wie Sie das neue Gerät installieren 
möchten. 
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1.	 Wenn Sie gefragt werden, ob Sie mit der Windows Update Webseite verbunden werden 
wollen, wählen sie “Nein”.

2.	 Wählen Sie „Automatische Installation“ (Windows XP) bzw. “Treibersoftware suchen 
und installieren” (Windows Vista) und folgen Sie den Anweisungen, um diesen Vorgang 
abzuschließen.

	

3.	 Follow the on-screen instructions to complete this procedure.

4.	 Während der Installation des Treibers werden einige Windows Sicherheitswarnungen an-
gezeigt, z.B. “Die Treiber-Software hat den Windows Logo Test nicht bestanden” oder 
“Windows kann den Herausgeber dieser Treiber-Software nicht verifizieren“. Klicken Sie 
einfach auf “Installation trotzdem fortsetzen” (XP) bzw. “Treiber trotzdem installieren” 
(Vista), um die Installation fortzusetzen.

Auf Windows Rechnern wird der Treiber mit einem bestimmten USB Port assoziiert. Wenn 
Sie das USB-Kabel mit einem anderen USB-Port verbinden, kann es deshalb vorkommen, 
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dass der beschriebene Vorgang erneut startet. Falls dies passiert, folgen Sie bitte einfach den 
oben erläuterten Schritten. 

Falls Probleme auftreten, trennen Sie die Verbindung und warten Sie einige Sekunden. Beim 
erneuten Verbinden sollte das Interface erkannt werden. Falls das Problem weiter besteht, 
starten Sie den Computer mit angesclossenem GUITAR RIG MOBILE I/O neu.

4.3	 Konfiguration

Dieses Kapitel beschreibt, wie Sie die RIG KONTROL für die Benutzung unter Windows XP/ 
Vista und insbesondere mit der GUITAR RIG 4 Software einrichten. Es wird vorausgesetzt, 
dass Sie Ihre Installation von GUITAR RIG 4 bereits mit dem Service Center aktiviert haben 
– bitte lesen Sie den Setup Guide, um mehr zu erfahren.

4.3.1	 GUITAR RIG 4 konfigurieren
Wir werden nun Ihr GUITAR RIG MOBILE I/O Audio Interface unter GUITAR RIG 4 einrichten. 

1.	 Beim ersten Start der Software wird automatisch der Dialog “Audio Setup” geöffnet, in 
dem Sie die notwendigen Einstellungen vornehmen können. Um diese Einstellungen spä-
ter zu bearbeiten, wählen Sie File > Audio and MIDI Settings aus dem Programm-Menü.



GUITAR RIG MOBILE – 19

	

2.	 Wählen Sie auf der Audio Registerkarte ASIO als “Driver” aus.

3.	 Wählen Sie danach im Menü Device den Eintrag GUITAR RIG MOBILE I/O (2 In, 2 Out) 
als Ausgabegerät für die Software.

Falls GUITAR RIG MOBILE I/O nicht in der Liste auftaucht, starten Sie den Installationsvorgang 
erneut (siehe Abschnitt 4.1). 

Sie können das Driver Control Panel durch einen Klick auf „ASIO Config“ öffnen. Dort wird 
Ihnen durch die beiden Statusfelder am unteren Rand angezeigt, ob GUITAR RIG MOBILE 
I/O angeschlossen ist und ordnungsgemäß funktioniert.
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Das Audio Interface lässt sich über folgende Parametern konfigurieren:

•• Presets: Es werden verschiedene Presets zur Konfiguration für übliche Situationen angebo-
ten – von minimal latency für Systeme mit hoher Prozessorleistung bis zu high latency für 
langsamere Computer. Wenn Sie mit der Konfiguration von Audio-Treibern schon Erfahrung 
haben und eine eigene Einstellung vornehmen wollen, wählen Sie User Defined Settings 
(siehe folgende Abschnitte).

•• USB Buffersize und Audio Buffersize: Diese Parameter sind ausgegraut, wenn Sie im Menü 
Presets nicht User Defined Settings gewählt haben. Gemeinsam bestimmen beide Werte 
die Latenz des Systems – also die Zeit, die nach dem Anschlagen einer Saite verstreicht, 
bis Sie einen Klang im Kopfhörer oder in den Lautsprechern wahrnehmen. Der Wert für 
Audio Buffersize muss stets mindestens doppelt so groß sein wie der Wert für USB Buffersize. 
Bedenken Sie, dass der für USB Buffersize gewählte Wert direkt die CPU-Last Ihres Systems 
beeinflusst. Die resultierende CPU-Last variiert bei verschiedenen Systemen, sodass es 
sinnvoll sein kann, mit verschiedenen Einstellungen zu experimentieren.
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•• Sample Rate: Wählen Sie eine Samplerate, die mit Ihrer Musiksoftware kompatibel und auf 
die Prozessorleistung Ihres Computers abgestimmt ist. Als Standard ist die Samplerate auf 
44100 Hz (CD-Qualität) eingestellt. Höhere Sampleraten können die Soundqualität verbes-
sern, verursachen jedoch gleichzeitig eine höhere CPU-Last.

Es ist zu empfehlen, dass Sie zunächst eines der drei obersten Presets auswählen und mit der 
Installation fortfahren. Nachdem diese abgeschlossen ist, sollten Sie einen unverzerrten Sound 
einstellen und die Audio and MIDI Settings erneut aufrufen, um die bestmögliche Latenz für 
Ihr System zu erzielen. Wenn die Audio-Ausgabe mit dem Preset minimal latency unterbro-
chen oder fehlerhaft erscheint, versuchen Sie die Einstellungen low latency oder standard 
latency. Eine höhere Latenz verringert die Wahrscheinlichkeit einer fehlerhaften Wiedergabe.

4.3.2	 GUITAR RIG MOBILE I/O als Standard-Audio-Interface einrichten
Wenn Sie GUITAR RIG MOBILE I/O für die Wiedergabe sämtlicher Audio-Software (nicht 
nur für die Musikproduktion) benutzen wollen, müssen Sie es als Standard-Audio-Interface 
einrichten.

Unter Windows XP gehen Sie folgendermaßen vor:

1.	 Öffnen Sie Start > Systemsteuerung > Sounds und Audiogeräte.

2.	 Wählen Sie die Registerkarte “Audio”.

3.	 Wählen Sie als Default Device im Bereich „Soundwiedergabe“ und „Soundaufnahme“ 
den Eintrag GUITAR RIG MOBILE I/O.

4.	 Klicken Sie auf OK, um den Dialog zu schließen.
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Unter Windows Vista gehen Sie folgendermaßen vor:

1.	 Öffnen Sie Start > Systemsteuerung > Hardware und Sound > Sound.

2.	 Gehen Sie auf die Registerkarte “Wiedergabe”.

3.	 Wählen Sie in der Geräteliste GUITAR RIG MOBILE I/O aus und klicken Sie auf „Als 
Standard“.

4.	 Gehen Sie auf die Registerkarte “Aufnahme”.

5.	 Wählen Sie in der Geräteliste GUITAR RIG MOBILE I/O aus und klicken Sie auf „Als 
Standard“.

6.	 Klicken Sie auf OK, um den Dialog zu schließen.
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4.4	 Audio-Verbindungen und Pegel

In den folgenden Kapiteln erfahren Sie, wie Sie Ihre Gitarre oder Ihren Bass und Ihr 
Wiedergabe-System an GUITAR RIG MOBILE I/O anschließen, und wie Sie die richtige 
Verstärkung einstellen, sowohl auf Seiten der Hardware als auch in der Software.

Bitte starten Sie GUITAR RIG 4, bevor Sie fortfahren.

4.4.1	 Anschließen des Audio-Eingangs und Anpassen des Eingangspegels
1.	 Bitte drehen Sie die Lautstärke Ihres Wiedergabesystems komplett herunter, um 

Gehörschädigung vorzubeugen.

2.	 Verbinden Sie Ihre Gitarre oder Ihren Bass mit einem entsprechenden Kabel mit einem 
der Eingangsstecker der RIG KONTROL.

Schließen Sie Ihre Gitarre oder Ihren Bass mit einem geeigneten Kabel an die Eingangsbuchse 
des GUITAR RIG MOBILE I/O. Falls Sie ein Instrument mit Stereo-Ausgang anschließen wol-
len, kann ein spezieller Adapter (Insert-Kabel/ Y-Kabel, nicht enthalten) notwendig sein, um 
beide Kanäle zu übertragen.
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Um die optimale Klangqualität zu erzielen, müssen Sie das Interface mit einem ausrei-
chend verstärkten Eingangssignal ansteuern. Dazu müssen Sie den Regler “Input Level” 
(Eingangsempfindlichkeit) des GUITAR RIG MOBILE I/O sorgfältig einstellen.

Das Eingangs-Pegelanzeige hilft Ihnen bei der korrekten Vorverstärkung Ihres Signals.

Pegelanzeige Bedeutung

LED ist aus Kein Eingangssignal

Die LED leuchtet grün Ein Eingangssignal liegt vor

Die LED leuchtet rot Eingangssignal ist zu laut

Bitte drehen Sie die Lautstärke Ihres Instruments auf, bevor Sie die folgenden Schritte vor-
nehmen. Spielen Sie einige Akkorde in der gewohnten Lautstärke und schauen Sie auf die 
Input-LED.

1.	 Drehen Sie den “Input Level” Regler auf, bis die LED anfängt, rot zu leuchten, während 
Sie spielen.

2.	 An diesem Punkt müssen Sie den Regler sachte zurückdrehen, bis die LED auch nicht 
mehr rot leuchtet, wenn Sie sehr laut spielen.

Nun ist die Eingangsempfindlichkeit optimal eingestellt, was dem GUITAR RIG MOBILE I/O 
ermöglicht, die größte dynamische Bandbreite ohne Übersteuerung zu verarbeiten.

Das Input-Level in GUITAR RIG 4
Es wird vorausgesetzt, dass Ihre Gitarre nun mit dem GUITAR RIG MOBILE I/O verbunden 
und die Eingangsempfindlichkeit optimal ausgesteuert ist (siehe Abschnitt 4.4.1. Nun müssen 
wir uns versichern, dass das Eingangssignal auch in der Software bei optimaler Lautstärke 
verarbeitet wird.
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Bitte richten Sie ihre Aufmerksamkeit auf die Kopfzeile des GUITAR RIG 4 Fensters. Sie ent-
hält die Input / Output Module, ein Noise Gate und einen Limiter, sowie Informationen über 
die Auslastung Ihrer CPU.

Achten Sie auf die Eingangs-Pegelanzeige in der Software - sie zeigt einen Ausschlag, 
wenn Sie spielen. Die Anzeige verfügt über einen integrierten Lautstärke-Regler, der die 
Eingangsverstärkung der Software regelt. Bitte stellen Sie ihn so ein, dass die höchstmögliche 
Lautstärke erreicht wird, ohne dass der Eingang übersteuert. Dies ist der Fall, wenn der Pegel 
nahe am roten Bereich der Anzeige ist, ohne diesen jemals zu erreichen.

Nun werden wir die INPUT-Komponente so einstellen, dass das Signal Ihrer Gitarre auf beiden 
Stereokanälen verarbeitet wird. Weil fast alle Gitarren ein Mono-Signal erzeugen, empfängt 
GUITAR RIG zunächst nur auf dem linken Kanal ein Signal. Da die Software standardmäßig 
so eingestellt ist, dass sie beide Eingangskanäle getrennt verarbeitet (L + R sind aktiviert), 
bleibt der rechte Kanal stumm. Um den nicht benutzten Kanal zu deaktivieren, klicken Sie 
auf den entsprechenden Buchstaben neben der Eingangspegel-Anzeige. Dies führt dazu, dass 
der linke Kanal auf beide Eingangskanäle gelenkt wird.

4.4.2	 Verbindung des Ausgangs
GUITAR RIG MOBILE I/O ist mit einem Stereo-Ausgang ausgestattet, der sowohl mit 
Verstärkersystemen als auch mit Kopfhöreren funktioniert. Bedenken Sie, dass die Verwendung 
eines Mono-Kabels (wie z.B. ein Gitarrenkabel) dazu führen wird, dass nur einer der beiden 
Kanäle übertragen wird. Abhängig vom Aufbau Ihres Verstärkersystems kann ein spezieller 
Adapter (Insert-Kabel/Y-Kabel, nicht enthalten) notwendig sein, um den Anschluss in Stereo 
zu gewährleisten.

Benutzen Sie ein Stereo-Kabel, um den Ausgang des GUITAR RIG MOBILE I/O mit Geräten 
zu verbinden, die einen Stereo-Eingang besitzen.
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Vergewissern Sie sich, bevor Sie Ihr Verstärker-System anschalten, und insbesondere bevor 
Sie Ihre Kopfhörer aufsetzen, dass die Ausgangslautstärke (der Regler “Output Level” des 
GUITAR RIG MOBILE I/O) vollständig heruntergedreht ist.

•• Verbinden Sie die Ausgangsbuchse des Interface mit dem Eingang Ihres Verstärkers und 
schalten sie den Verstärker ein. Stellen Sie die gewohnte Lautstärke ein.

•• Falls Sie Kopfhörer verwenden, verbinden Sie diesen mit der Ausgangsbuchse des Interface 
und setzen Sie sie auf, nachdem Sie die Lautstärke am Interface völlig heruntergedreht 
haben.

•• Öffnen Sie den Preset Browsers von GUITAR RIG 4 und suchen Sie sich ein Preset aus. 
Laden Sie es, indem Sie doppelt draufklicken. Drehen sie die Lautstärke vorsichtig auf, 
während Sie spielen, bis die gewünschte Lautstärke erreicht ist. Sie sind nun am Ende der 
Installation angelangt und können sofort loslegen!
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5	 Installation unter Mac OS X
Dieses Kapitel behandelt die Installation von GUITAR RIG MOBILE unter Mac OS X, mit 
Schwerpunkt auf dem GUITAR RIG MOBILE I/O Audio Interface. Detaillierte Informationen 
zu GUITAR RIG 4 finden Sie in den Software-Handbüchern. Sie finden diese im Ordner 
Documentation im GUITAR-RIG-Installationsverzeichnis; direkt öffnen können Sie es über das 
Programm-Menü von GUITAR RIG 4 unter Help > Open Manual > German.

5.1	 Installation der Software

Stellen Sie sicher, dass Sie mit Administrator-Rechten eingeloggt sind. Verbinden Sie das 
GUITAR RIG MOBILE I/O noch nicht mit ihrem Computer.

1.	 Navigieren Sie zum Inhalt der Installations-CD und finden Sie die Installations-Datei 
“Guitar Rig 4 Installer”. Falls Sie eine Download-Version von GUITAR RIG 4 benutzen, 
müssen Sie die Installations-Datei zunächst entpacken.

2.	 Doppelklicken Sie auf die Installations-Datei, um den Installationsprozess zu beginnen.
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3.	 Folgen Sie den Anweisungen auf dem Bildschirm, um durch den Installationsprozess 
geführt zu werden.

4.	 Sie werden gefragt, ob Sie Treiber für ein GUITAR RIG Audio Interface installieren möch-
ten. Wählen Sie “MOBILE I/O” und klicken Sie auf “Fortsetzen”.

5.	 Starten Sie Ihren Computer nach der Installation neu.

Das Installationsprogramm platziert die folgende Software auf ihrem Computer:

•• GUITAR RIG 4 – die eigenständige Software.

•• GUITAR RIG 4 Plug-Ins – GUITAR RIG 4 lässt sich als Plug-In für Ihre Digital Audio 
Workstation (DAW) benutzen.

•• NATIVE INSTRUMENTS SERVICE CENTER – Diese Anwendung ist für die Produktaktivierung 
und das Update-Management zuständig. Bitte konsultieren Sie den Setup Guide für Details 
zur Produktaktivierung.

•• Die Treiber für das GUITAR RIG MOBILE I/O Audio Interface.

% 
Wenn Sie bisher noch kein Produkt von Native Instruments besitzen, müssen Sie sich 
bei Native Instruments registrieren, indem Sie den Anweisungen auf den Bildschirm 

folgen. Mehr Informationen über die Erstellung eines NI User Accounts und über die Aktivierung 
von GUITAR RIG finden Sie im Setup Guide und im Service-Center-Handbuch.

Falls Sie nur die Hardware-Treiber installieren wollen, finden Sie dafür auf der 
Installations-CD eine separate Installations-Datei. Die aktuelle Treiberversion finden 
Sie jederzeit im Bereich „Support“ der Native-Instruments-Website.
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5.2	 Installation der Hardware

Benutzen Sie das mitgelieferte USB-Kabel, um das GUITAR RIG MOBILE I/O direkt an einen 
USB-2.0-Port Ihres Computers anzuschließen.

GUITAR RIG MOBILE I/O wird per USB mit Strom versorgt. Die Funktion kann nur garantiert 
werden, wenn Sie es als einziges Gerät direkt an einem USB-2.0-Controller oder an einem 
USB-2.0-Hub mit eigener Stromversorgung betreiben.

Nach der erfolgreichen Installation wird das GUITAR RIG MOBILE I/O beim Herstellen der 
Verbindung automatisch erkannt. Falls Probleme auftreten, trennen Sie die Verbindung und 
warten Sie einige Sekunden. Beim erneuten Verbinden sollte das Interface erkannt werden. 
Falls das Problem weiter besteht, starten Sie den Computer mit bestehender Verbindung zum 
Interface neu.
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5.3	 Konfiguration

Dieses Kapitel beschreibt, wie Sie die RIG KONTROL für die Benutzung unter Mac OS und 
insbesondere mit der GUITAR RIG 4 Software einrichten. Es wird vorausgesetzt, dass Sie Ihre 
Installation von GUITAR RIG 4 bereits mit dem Service Center aktiviert haben – bitte lesen 
Sie den Setup Guide, um mehr zu erfahren

5.3.1	 GUITAR RIG 4 konfigurieren
Wir werden nun Ihr GUITAR RIG MOBILE I/O Audio Interface unter GUITAR RIG 4 einrichten. 

1.	 Starten Sie GUITAR RIG 4. Beim ersten Start der Software wird automatisch der Dialog 
“Audio Setup” geöffnet, in dem Sie die notwendigen Einstellungen vornehmen können. 
Um diese Einstellungen später zu bearbeiten, wählen Sie Guitar Rig 4 > Preferences aus 
dem Programm-Menü.

	

2.	 Wählen Sie auf der Audio Registerkarte Core Audio als “Driver” aus.

3.	 Wählen Sie danach GUITAR RIG MOBILE I/O als „Device“ für den Ausgang der Software.
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Falls RIG KONTROL nicht in der Liste auftaucht, ist etwas schief gelaufen. Starten Sie die 
Installation erneut wie oben beschrieben.

Das Audio Interface lässt sich über folgende Parametern konfigurieren:

•• Sample Rate: Wählen Sie eine Samplerate, die mit Ihrer Musiksoftware kompatibel und auf 
die Prozessorleistung Ihres Computers abgestimmt ist. Als Standard ist die Samplerate auf 
44100 Hz (CD-Qualität) eingestellt. Höhere Sampleraten können die Soundqualität verbes-
sern, verursachen jedoch gleichzeitig eine höhere CPU-Last.

•• Latency: Benutzen Sie den Schieberegler Latency, um die Puffergröße des Audio Interface 
einzustellen. Die Puffergröße wird in Samples gemessen und hat zwei Auswirkungen: Je 
höher die Puffergröße gesetzt ist, desto geringer ist die Wahrscheinlichkeit von Fehlern wäh-
rend der Echtzeitverarbeitung von Audiosignalen. Andererseits wirkt sich die Puffergröße 
direkt auf die Latenz Ihres Systems aus – je höher sie gesetzt ist, desto länger ist der 
Zeitraum zwischen dem Moment, in dem Sie einen Ton anschlagen und dem Moment, in 
dem Sie den verarbeiteten Klang hören. 

Es ist zu empfehlen, dass Sie zunächst die Standardeinstellung belassen und mit der 
Installation fortfahren. Nachdem diese abgeschlossen ist, sollten Sie einen unverzerrten Sound 
einstellen und die Audio and MIDI Settings erneut aufrufen, um die bestmögliche Latenz für 
Ihr System zu erzielen. Dies erfolgt durch eine behutsame Reduzierung der Puffergröße: Ziehen 
Sie den Schieberegler nach links, während Sie etwas spielen. Sobald Sie ein Knacksen oder 
Unterbrechungen in der Wiedergabe wahrnehmen, müssen Sie den Regler wieder ein wenig 
nach recht bewegen, bis keine Fehler mehr auftreten.

5.3.2	 GUITAR RIG MOBILE I/O als Standard-Audio-Interface einrichten
Wenn Sie GUITAR RIG MOBILE I/O für die Wiedergabe sämtlicher Audio-Software (nicht nur 
für die Musikproduktion) benutzen wollen, müssen Sie es als Standard Audio Interface ein-
richten. Unter Mac OS X funktioniert das so:

1.	 Öffnen Sie die Systemeinstellungen aus dem Apple-Menü.

2.	 Wählen Sie den Eintrag “Sound“.
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3.	 Wählen Sie auf dem Tab Sound Effects im Menü „Warntöne und Klangeffekte abspielen 
über“ den Eintrag GUITAR RIG MOBILE I/O.

4.	 Wählen Sie auf der Registerkarte “Wiedergabe” GUITAR RIG MOBILE I/O aus der Liste 
„Wählen Sie ein Gerät für die Sound-Wiedergabe“.

5.	 Wählen Sie auf der Registerkarte “Aufnahme” GUITAR RIG MOBILE I/O aus der Liste 
„Wählen Sie ein Gerät für die Sound-Aufnahme“.

5.4	 Audio-Verbindungen und Pegel

In den folgenden Kapiteln erfahren Sie, wie Sie Ihre Gitarre oder Ihren Bass und Ihr 
Wiedergabe-System an GUITAR RIG MOBILE I/O anschließen, und wie Sie die richtige 
Verstärkung einstellen, sowohl auf Seiten der Hardware als auch in der Software.

Bitte starten Sie GUITAR RIG 4, bevor Sie fortfahren.



GUITAR RIG MOBILE – 33

5.4.1	 Anschließen des Audio-Eingangs und Anpassen des Eingangspegels
1.	 Bitte drehen Sie die Lautstärke Ihres Wiedergabesystems komplett herunter, um 

Gehörschädigung vorzubeugen.

2.	 Verbinden Sie Ihre Gitarre oder Ihren Bass mit einem entsprechenden Kabel mit einem 
der Eingangsstecker der RIG KONTROL.

3.	 Schließen Sie Ihre Gitarre oder Ihren Bass mit einem geeigneten Kabel an die 
Eingangsbuchse des GUITAR RIG MOBILE I/O. Falls Sie ein Instrument mit Stereo-
Ausgang anschließen wollen, kann ein spezieller Adapter (Insert-Kabel/ Y-Kabel, nicht 
enthalten) notwendig sein, um beide Kanäle zu übertragen.

Um die optimale Klangqualität zu erzielen, müssen Sie das Interface mit einem ausrei-
chend verstärkten Eingangssignal ansteuern. Dazu müssen Sie den Regler “Input Level” 
(Eingangsempfindlichkeit) des GUITAR RIG MOBILE I/O sorgfältig einstellen.

Das Eingangs-Pegelanzeige hilft Ihnen bei der korrekten Vorverstärkung Ihres Signals.
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Pegelanzeige Bedeutung

LED ist aus Kein Eingangssignal

Die LED leuchtet grün Ein Eingangssignal liegt vor

Die LED leuchtet rot Eingangssignal ist zu laut

Bitte drehen Sie die Lautstärke Ihres Instruments auf, bevor Sie die folgenden Schritte vor-
nehmen. Spielen Sie einige Akkorde in der gewohnten Lautstärke und schauen Sie auf die 
Input-LED.

1.	 Drehen Sie den “Input Level” Regler auf, bis die LED anfängt, rot zu leuchten, während 
Sie spielen.

2.	 An diesem Punkt müssen Sie den Regler sachte zurückdrehen, bis die LED auch nicht 
mehr rot leuchtet, wenn Sie sehr laut spielen.

Nun ist die Eingangsempfindlichkeit optimal eingestellt, was dem GUITAR RIG MOBILE I/O 
ermöglicht, die größte dynamische Bandbreite ohne Übersteuerung zu verarbeiten.

5.4.2	 Das Input-Level in GUITAR RIG 4
Es wird vorausgesetzt, dass Ihre Gitarre nun mit dem GUITAR RIG MOBILE I/O verbunden 
und die Eingangsempfindlichkeit optimal ausgesteuert ist (siehe Abschnitt 5.4.1). Nun müssen 
wir uns versichern, dass das Eingangssignal auch in der Software bei optimaler Lautstärke 
verarbeitet wird.

Bitte richten Sie ihre Aufmerksamkeit auf die Kopfzeile des GUITAR RIG 4 Fensters. Sie ent-
hält die Input / Output Module, ein Noise Gate und einen Limiter, sowie Informationen über 
die Auslastung Ihrer CPU.
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Achten Sie auf die Eingangs-Pegelanzeige in der Software - sie zeigt einen Ausschlag, 
wenn Sie spielen. Die Anzeige verfügt über einen integrierten Lautstärke-Regler, der die 
Eingangsverstärkung der Software regelt. Bitte stellen Sie ihn so ein, dass die höchstmögliche 
Lautstärke erreicht wird, ohne dass der Eingang übersteuert. Dies ist der Fall, wenn der Pegel 
nahe am roten Bereich der Anzeige ist, ohne diesen jemals zu erreichen.

Nun werden wir die INPUT-Komponente so einstellen, dass das Signal Ihrer Gitarre auf beiden 
Stereokanälen verarbeitet wird. Weil fast alle Gitarren ein Mono-Signal erzeugen, empfängt 
GUITAR RIG zunächst nur auf dem linken Kanal ein Signal. Da die Software standardmäßig 
so eingestellt ist, dass sie beide Eingangskanäle getrennt verarbeitet (L + R sind aktiviert), 
bleibt der rechte Kanal stumm. Um den nicht benutzten Kanal zu deaktivieren, klicken Sie 
auf den entsprechenden Buchstaben neben der Eingangspegel-Anzeige. Dies führt dazu, dass 
der linke Kanal auf beide Eingangskanäle gelenkt wird.

5.4.3	 Verbindung des Ausgangs
GUITAR RIG MOBILE I/O ist mit einem Stereo-Ausgang ausgestattet, der sowohl mit 
Verstärkersystemen als auch mit Kopfhöreren funktioniert. Bedenken Sie, dass die Verwendung 
eines Mono-Kabels (wie z.B. ein Gitarrenkabel) dazu führen wird, dass nur einer der beiden 
Kanäle übertragen wird. Abhängig vom Aufbau Ihres Verstärkersystems kann ein spezieller 
Adapter (Insert-Kabel/Y-Kabel, nicht enthalten) notwendig sein, um den Anschluss in Stereo 
zu gewährleisten.

Benutzen Sie ein Stereo-Kabel, um den Ausgang des GUITAR RIG MOBILE I/O mit Geräten 
zu verbinden, die einen Stereo-Eingang besitzen.
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Vergewissern Sie sich, bevor Sie Ihr Verstärker-System anschalten, und insbesondere bevor 
Sie Ihre Kopfhörer aufsetzen, dass die Ausgangslautstärke (der Regler “Output Level” des 
GUITAR RIG MOBILE I/O) vollständig heruntergedreht ist.

•• Verbinden Sie die Ausgangsbuchse des Interface mit dem Eingang Ihres Verstärkers und 
schalten sie den Verstärker ein. Stellen Sie die gewohnte Lautstärke ein.

•• Falls Sie Kopfhörer verwenden, verbinden Sie diesen mit der Ausgangsbuchse des Interface 
und setzen Sie sie auf, nachdem Sie die Lautstärke am Interface völlig heruntergedreht 
haben.

•• Öffnen Sie den Preset Browsers von GUITAR RIG 4 und suchen Sie sich ein Preset aus. 
Laden Sie es, indem Sie doppelt draufklicken. Drehen sie die Lautstärke vorsichtig auf, 
während Sie spielen, bis die gewünschte Lautstärke erreicht ist. Sie sind nun am Ende der 
Installation angelangt und können sofort loslegen!
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6	 Fehlersuche
Sollten Sie auf Probleme mit Ihrer Hardware stoßen, führen Sie die folgenden Schritte durch, 
um eine Lösung zu finden, bevor Sie den Technischen Support kontaktieren:

•• Besuchen Sie die NI Knowledge Base im Internet. Am einfachsten finden Sie die Knowledge 
Base, indem Sie in GUITAR RIG 4 aus dem Help-Menü den Eintrag Knowledgebase wählen.

•• Besuchen Sie das NI User Forum auf unserer Website (http://www.native-instruments.com/
forum/) und suchen Sie nach hilfreichen Antworten von GUITAR-RIG-Nutzern.

Bevor Sie den Technischen Support kontaktieren, stellen Sie bitte sicher, dass Sie alle rele-
vanten Informationen zu Ihrem Computer zur Hand haben. Für Informationen zur Treiber- und 
Firmwareversion, konsultieren Sie das Driver Control Panel.

•• Auf Computern mit Windows-Betriebssystem finden Sie es im Ordner Start > Programs > 
Native Instruments > Guitar Rig Mobile IO Driver der GUITAR RIG 4 Software im Startmenü. 
Die Informationen werden angezeigt, wenn Sie auf „About“ klicken.

•• Auf Computern mit dem Betriebssystem Mac OS X können Sie das Driver Control Panel aus 
den Systemeinstellungen aufrufen. Die Informationen werden im Hauptfenster angezeigt.

Bitte besuchen Sie die folgende URL, um das Support Team zu kontaktieren: 

http://www.native-instruments.com/support/

Alle Produkte von Native Instruments werden während der Entwicklungsphase ausgiebig in 
verschiedenen Anwendungssituationen getestet. Sollte Ihr Produkt dennoch umgetauscht wer-
den müssen, wird Ihnen das Technik Support Team eine RA (Return Authorization) Nummer 
zuweisen, um die Verarbeitung Ihrer Umtauschware zu beschleunigen. Bitte kontaktieren Sie 
vor Einsendung jeglicher Ware unser Technik-Support-Team. Pakete, die ohne die RA-Nummer 
eingeschickt werden, können nicht genau zugeordnet und somit nicht mit der maximalen 
Geschwindigkeit bearbeitet werden.

http://www.native-instruments.com/forum/
http://www.native-instruments.com/forum/
http://www.native-instruments.com/support
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6.1	 Audio-Probleme beheben

Dieser Abschnitt enthält hilfreiche Informationen zu den häufigsten Audio-Problemen.

6.1.1	 Keine oder sehr leise Wiedergabe
Es gibt verschiedene Ursachen für einen stummen oder sehr leisen Audio-Ausgang:

•• Eine häufige Fehlerquelle sind fehlende Audioverbindungen oder defekte Kabel. Bitte über-
prüfen Sie sämtliche Verbindungen und alle Kabel auf ihre Funktion.

•• Falsche Soundkarte oder falscher Audio-Eingang ausgewählt. Überprüfen Sie bitte in den 
„Audio and MIDI Settings“ von GUITAR RIG 4, ob der Treiber des GUITAR RIG MOBILE I/O 
ausgewählt ist.

•• Im Input Modul von GUITAR RIG 4 kann der falsche Kanal selektiert sein. Schalten Sie in 
der Software auf den anderen Kanal um, indem Sie neben dem Eingangs-Pegel Links (L) 
oder Rechts (R) wählen.

•• Der Eingangspegel-Regler des GUITAR RIG MOBILE I/O ist möglicherweise zu niedrig ein-
gestellt. Drehen Sie den Regler auf, um den Eingangspegel zu erhöhen.

•• Der Lautstärkeregler Ihrer Gitarre ist heruntergeregelt. Drehen Sie den Regler auf.

6.1.2	 Verzerrtes Signal
Wenn die Tonausgabe verzerrt klingt, obwohl Sie keinen Distortion-Effekt einsetzen, ist mög-
licherweise die Eingangsempfindlichkeit des Session I/O zu hoch eingestellt. Bitte regeln 
Sie das „Input Level“ am GUITAR RIG MOBILE I/O herunter, um eine Übersteuerung der 
Vorstufe zu vermeiden. Sollte sich die Übersteuerung der Vorstufe so nicht beheben lassen, 
verringern Sie bitte die Lautstärke an der Gitarre selbst. Dieser Fall tritt normalerweise nur 
bei Gitarren und Bässen mit aktiver Elektronik und Tonabnehmern mit besonders starkem 
Ausgangssignal auf.
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6.1.3	 Störgeräusche
Vernehmbares Brummen in der Wiedergabe kann verschiedene Ursachen haben:

•• Single-Coil-Tonabnehmer sind sehr anfällig für elektrische Einstreuungen, die Brummen 
verursachen können. Humbucker sind in dieser Hinsicht deutlich weniger sensibel.

•• Die Tonabnehmer befinden sich in der Nähe von elektrischen Geräten. Um das Brummen 
zu reduzieren, entfernen Sie die Gitarre weiter von den Geräten.

•• Der Lautstärkeregler der Gitarre ist nicht weit genug aufgedreht. Drehen Sie den Regler auf. 
Sollte Ihre Gitarre mehrere Regler haben, überprüfen Sie bitte alle Einstellungen.

•• Sie benutzen ein ungeschirmtes oder defektes Gitarrenkabel. Tauschen Sie in einem solchen 
Fall Ihr Gitarrenkabel gegen ein hochwertiges, abgeschirmtes Modell aus. Die Abschirmung 
Ihrer Gitarre kann ebenfalls unzureichend sein. Ein Fachmann kann Ihre Gitarre instandset-
zen und eine neue Abschirmung anbringen.

Falls Sie starkes Rauschen vernehmen, könnte es an einer unzureichenden Vorverstärkung 
durch das MOBILE I/O liegen. Stellen Sie sicher, dass die Lautstärke Ihres Instruments voll 
aufgedreht ist, und drehen Sie den Input Gain des entsprechenden Eingangs auf. Bitte lesen 
Sie Kapitel 4.4 (Windows XP/Vista) bzw. Kapitel 5.4 (Mac OS X) dieses Handbuchs, um mehr 
über die richtige Justierung des Eingangspegels zu erfahren.

6.1.4	 Masseschleifen
Masseschleifen (normalerweise als Brummen oder Summen wahrgenommen) sind ein ver-
breitetes Problem, wenn verschiedene elektrische Geräte an den gleichen Stromkreis ange-
schlossen sind. Die folgenden Schritte sollten bei der Behebung helfen:

•• Trennen Sie alle Geräte vom Stromkreis, die Sie zur Zeit nicht benutzen, z.B. Peripheriegeräte 
Ihres Computers (externe Festplatten, CD-Brenner).

•• Schalten Sie eine DI-Box zwischen den Ausgang des GUITAR RIG MOBILE I/O und den 
Eingang Ihres Verstärkers. Die meisten DI-Boxen verfügen über einen „Ground Lift“-Schalter, 
der es ermöglicht, die Masseschleife zu unterbrechen.
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6.2	 Probleme mit der Hardware

Weitere Informationen, Software-Updates sowie die neuste Treiber-Version für GUITAR RIG 
MOBILE I/O erhalten Sie auf der Native-Instruments-Website und über das NI Service Center.

6.2.1	 Treiberprobleme
Stellen Sie sicher, dass das GUITAR RIG MOBILE I/O mit dem Computer verbunden ist und 
öffnen Sie das Driver Control Panel (siehe oben). Am Anfang dieses Kapitels ist erklärt, wo 
sich das Driver Control Panel befindet.

Falls das Driver Control Panel nicht auffindbar ist, ist der Treiber mit hoher Wahrscheinlichkeit 
nicht installiert. In diesem Falle installieren Sie den Treiber bitte erneut wie oben beschrieben.

Falls im Driver Control Panel alle Menüs ausgegraut sind, wird das GUITAR RIG MOBILE I/O 
nicht vom Treiber erkannt. Dies kann an einer fehlerhaften USB-Verbindung liegen – lesen 
Sie den folgenden Abschnitt für Details.

6.2.2	 USB-Probleme
GUITAR RIG MOBILE I/O ist ein USB-2.0-Interface und funktioniert nicht an einem USB-
1.0/- oder 1.1-Port. Verbinden Sie es stets direkt mit einem USB 2.0 Port Ihres Computers. 
Verbinden Sie das MOBILE I/O stets direkt mit einem USB-2.0-Port an Ihrem Computer. Die 
Stromversorgung des Ports muss die Mindestanforderungen für USB 2.0 erfüllen, also einen 
Strom von 500 mA liefern können. An manchen Computern erfüllen die USB-2.0-Ports die 
offiziellen USB-2.0-Spezifikationen nicht. In diesem Fall erscheint eventuell eine Warnmeldung, 
die Sie darauf hinweist, dass nicht genug Strom für die Versorgung Ihres Geräts zur Verfügung 
steht. Das MOBILE I/O wird nur fehlerhaft oder gar nicht funktionieren.

•• Falls Ihr Computer nicht in der Lage ist, eine ausreichende Stromversorgung zu garantieren, 
versuchen Sie, das GUITAR RIG MOBILE I/O als einziges Gerät an einen USB 2.0 Hub mit 
externer Stromversorgung anzuschließen. Vermeiden Sie es, weitere bus-gespeiste Geräte 
an den Hub anzuschließen, weil jedes zusätzliche Gerät die für die MOBILE I/O zur Verfügung 
stehende Stromstärke reduziert.
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•• Im Falle einer Funktionsstörung überprüfen Sie zunächst, ob das GUITAR RIG MOBILE I/O 
funktioniert, wenn Sie andere USB-Geräte von Ihrem Computer trennen.

•• Falls bei der Audio-Wiedergabe Aussetzer oder andere Probleme auftreten, verbinden Sie 
das GUITAR RIG MOBILE I/O mit einem anderen USB-2.0-Port.

•• Ein defektes USB-Kabel kann die Ursache für eine fehlerhafte Wiedergabe und andere 
Verbindungsprobleme sein. Versuchen Sie ein anderes Kabel mit dem offiziellen USB-Logo, 
in einigen Fällen kann die Verwendung eines kürzeren Kabels hilfreich sein.

•• Falls Sie auf einem Computer mit Windows-Betriebssystem Performance-Probleme und 
Abstürze mit dem GUITAR RIG MOBILE I/O erleben, sollten Sie zuerst das 
Energiemanagement für USB-Hubs deaktivieren. Öffnen Sie den Gerätemanager 
(Systemsteuerung > System > Hardware) und erweitern Sie die Liste der USB-Controller. 
Klicken Sie mit der rechten Maustaste auf einen der USB-Hubs, um seine Einstellungen zu 
bearbeiten. Deaktivieren Sie auf der Registerkarte „Energieverwaltung“ alle Checkboxen und 
wiederholen Sie den Vorgang für alle USB-Hubs in der Liste. Starten Sie Ihren Computer 
neu.

6.2.3	 GUITAR RIG MOBILE mit einem Laptop benutzen
Überprüfen Sie, ob Ihr Computer leistungsfähig genug ist, um Audiosignale ohne Aussetzer 
in Echtzeit zu verarbeiten. Es gibt einige Freeware-Programme, um Ihr System auf seine 
Zuverlässigkeit bei der Audio-Signalverarbeitung zu analysieren, zum Beispiel: 

www.thesycon.de/deu/latency_check.shtml

Trennen Sie die Verbindung zwischen GUITAR RIG MOBILE I/O und Ihrem Computer und 
starten Sie dann das Programm. Falls Ihr Computer nicht in der Lage ist, Audio in Echtzeit 
zu verarbeiten, werden Sie rote Balken und eine entsprechende Analyse in der Textbox sehen.

Es ist generell nicht zu empfehlen, Laptops mit Shared-Memory Grafikkarten zu benutzen. 
Sie werden den gesamten verfügbaren Speicher und die CPU-Leistung für Ihre Audioprojekte 
brauchen.

http://www.thesycon.de/deu/latency_check.shtml
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Dies sind einige nützliche Schritte, um die Audio-Performance Ihres Laptops zu steigern:

•• Verwenden Sie den Laptop möglichst nicht im Batteriebetrieb, da die Energieverwaltung die 
Taktrate der CPU herunterregeln kann, um Strom zu sparen.

•• Entfernen Sie jegliche Peripheriegeräte, die Sie nicht benutzen (Drucker, Scanner, etc.). Dies 
kann die verfügbare Prozessorleistung erhöhen.

•• Laptops sind häufig mit integrierten Geräten ausgestattet, die zu Fehlern in der Audio-
Verarbeitung führen können. Eine weit verbreitete Fehlerquelle sind Netzwerk- oder W-LAN-
Adapter. Es kann notwendig sein, diese Geräte zu deaktivieren, während Sie mit GUITAR 
RIG MOBILE I/O arbeiten.
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7	 Technische Spezifikation
Dieser Abschnitt enthält alle relevanten technischen Spezifikationen der GUITAR RIG MOBILE 
I/O Hardware.

7.1	 Anschlüsse und Buchsen:

•• 1 Stereo-Eingang (6,3-mm-Klinkenbuchse)

•• 1 Stereo-Ausgang (6,3-mm-Klinkenbuchse)

•• 1 USB-2.0-Port (Anschluss-Typ B)
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7.2	 Audio-Spezifikationen

Audio-Eingänge (A/D)

Kanäle 2

Sample Rate (Abtastfrequenz) 44.1, 48, 88.2, 96, 192 kHz

Bit-Auflösung 16, 24 Bit

Wandler Cirrus Logic

Instrumenten-Eingänge

Eingangswiderstand 1 MΩ unsymmetrisch

Endausschlagspegel bei maximalem Gain -4,8 dBu

Maximaler Eingangspegel +15,8 dBu unsymmetrisch

SNR (gewichtet) 100 dBu

THD + N 0,006%

Frequenzbereich (+/- 1dBu) 10-40000 Hz
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Audio-Ausgänge (D/A)

Kanäle 2

Sample Rate (Abtastfrequenz) 44.1, 48, 88.2, 96, 192 kHz

Bit-Auflösung 16, 24 Bit

Wandler Cirrus Logic

Line-Ausgänge

Ausgangswiderstand 100 Ohms unsymmetrisch, 200 Ohms symmetrisch

Maximaler Ausgangspegel +14,9dBu

SNR (gewichtet) 100dBu

THD + N 0,006%

Frequenzbereich (+/- 1dBu) 10-40000 Hz



GUITAR RIG MOBILE – 46

Kopfhörerausgang

Lastimpedanz 16-600 Ohm

Maximaler Ausgangspegel  
(100 Ohm Lastimpedanz) 

2,165 V RMS (100 Ohm Lastimpedanz), 4,345 V RMS  
(keine Lastimpedanz)

SNR (gewichtet) 100dB

Klirrfaktor (THD+N, bei 100 Ohm) 0,06%

Frequenzbereich (+/- 1dBu) 10-40000 Hz

7.3	 Stromversorgung

via USB 2.0 Schnittstelle (Buspower mit 5 V, 500 mA)

Es wird nur Strom vom USB-Bus benötigt, kein Netzteil oder Batterie erforderlich. Die Funktion 
kann nur garantiert werden, wenn dieses Produkt entweder als einziges Gerät am USB-2.0-
Controller oder über einen USB-2.0-Hub mit eigener Stromversorgung betrieben wird.

7.4	 Abmessungen und Gewicht

Abmessungen und Gewicht: 90 x 58 x 24 mm (3.54 x 2.28 x 0.94 in)

Gewicht: 90 g (0.198 lb)
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7.5	 Umgebungsbedingungen

Betriebstemperatur: 0°C to 40°C (32°F to 104°F) (85% Luftfeuchtigkeit, nicht kondensierend)

Lagertemperatur: -20°C to 50°C (-4°F to 122°F) (85% relative Luftfeuchtigkeit)

7.6	 System-Anforderungen

7.6.1	 Allgemeine Systemanforderungen
Windows XP mit Service Pack 2 oder Windows Vista™ (32/64 Bit), Intel®-Pentium™- oder 
AMD®-Athlon™-XP-CPU ab 1,4 GHz, 1024 MB RAM, USB 2.0

Mac OS 10.5, Intel® Core™ Duo ab 1.66 GHz, 1024 MB RAM, USB 2.0

7.6.2	 Unterstützte Treiberschnittstellen
•• Mac OS: Core Audio™

•• Windows: ASIO® (empfohlen), DirectSound™, WASAPI™

7.6.3	 Unterstützte Plattformen
•• Mac OS X: Stand-alone, VST®, Audio Units™, RTAS® (Pro Tools 7/8)

•• Windows: Stand-alone, VST®, RTAS® (Pro Tools 7/8)


	1	Willkommen zu GUITAR RIG MOBILE!
	2	Vor der Inbetriebnahme – Wichtige Hinweise
	2.1	Seriennummern & Typenschild
	2.2	Sicheres Verwenden des Geräts
	2.2.1	Achtung
	2.2.2	Vorsicht
	2.2.3	Entsorgung

	2.3	Haftungsausschluss

	3	Bestandteile des GUITAR RIG MOBILE I/O Audio Interface
	4	Installation unter Windows XP/Vista
	4.1	Installation der Software
	4.2	Installation der Hardware
	4.3	Konfiguration
	4.3.1	GUITAR RIG 4 konfigurieren
	4.3.2	GUITAR RIG MOBILE I/O als Standard-Audio-Interface einrichten

	4.4	Audio-Verbindungen und Pegel
	4.4.1	Anschließen des Audio-Eingangs und Anpassen des Eingangspegels
	4.4.2	Verbindung des Ausgangs


	5	Installation unter Mac OS X
	5.1	Installation der Software
	5.2	Installation der Hardware
	5.3	Konfiguration
	5.3.1	GUITAR RIG 4 konfigurieren
	5.3.2	GUITAR RIG MOBILE I/O als Standard-Audio-Interface einrichten

	5.4	Audio-Verbindungen und Pegel
	5.4.1	Anschließen des Audio-Eingangs und Anpassen des Eingangspegels
	5.4.2	Das Input-Level in GUITAR RIG 4
	5.4.3	Verbindung des Ausgangs


	6	Fehlersuche
	6.1	Audio-Probleme beheben
	6.1.1	Keine oder sehr leise Wiedergabe
	6.1.2	Verzerrtes Signal
	6.1.3	Störgeräusche
	6.1.4	Masseschleifen

	6.2	Probleme mit der Hardware
	6.2.1	Treiberprobleme
	6.2.2	USB-Probleme
	6.2.3	GUITAR RIG MOBILE mit einem Laptop benutzen


	7	Technische Spezifikation
	7.1	Anschlüsse und Buchsen:
	7.2	Audio-Spezifikationen
	7.3	Stromversorgung
	7.4	Abmessungen und Gewicht
	7.5	Umgebungsbedingungen
	7.6	System-Anforderungen
	7.6.1	Allgemeine Systemanforderungen
	7.6.2	Unterstützte Treiberschnittstellen
	7.6.3	Unterstützte Plattformen



